
 

 

 

 

 

 

 

 

Integrating Excel with  
Word and PowerPoint 

 

 

Excel is the accountants' tool of choice for analyzing data, but their analyses often find their way into 
formal reports and presentations. Most accountants and business professionals use simple cut-and-paste 
processes or rekey their analyses to integrate them into Word and PowerPoint; however, these Microsoft 
Office products offer a full range of options for integrating data among and between them. This session 
contains all of the tips, tricks, and techniques necessary to ease the process of integrating Excel with Word 
and PowerPoint. 

  



 
 

Introduction 
Excel is the accountants' tool of choice for analyzing data, but their analyses often find their way into 
formal reports and presentations. Most accountants and business professionals use simple cut-and-paste 
processes or rekey their analyses to integrate them into Word and PowerPoint; however, these Microsoft 
Office products offer a full range of options for integrating data among and between them. Tables and 
text in Word documents and PowerPoint presentations can be linked and updated as analyses in Excel is 
updated or changed. Alternatively, existing or new Excel analyses can be embedded in Word or 
PowerPoint so that users do not have to manage linked documents. Linking summary data in reports and 
presentations to the underlying detail in the source documents is easily accomplished with hyperlinks. 
This session contains all of the tips, tricks, and techniques necessary to ease the process of integrating 
Excel with Word and PowerPoint. 

Learning Objectives 
Upon completing this session, participants should be able to: 

• Use linked or embedded Excel analysis to automate the process of updating reports or 
presentations; 

• List the eight ways in which Excel data can be pasted into Word; 

• Describe the process of linking or embedding multi-page Excel objects into Word; 

• Explain how to modify the Quick Access Toolbar to facilitate working with hyperlinked documents; 
and 

• Describe how to link data cells from Excel into Word text, such as in notes to financial statements. 

 

 

 

 

 

 

 

  



 
 

Embedding Objects in Office Applications 

In assembling reports for printing, users often cut and paste financial data from Excel into Word and, to a 
lesser degree, text from Word documents into Excel. Other users link or embed Excel objects in Word or 
embed Word objects in Excel using the Object Linking and Embedding (OLE) capabilities of Windows and 
Office. Pasting linked or embedded objects differs from pasting static text or financial data. With a linked 
or embedded object, it is possible to open and edit the object in place. In other words, a user can edit a 
linked or embedded Excel worksheet from within Word, or edit a linked or embedded Word document 
from within Excel. This saves time and improves productivity. Whenever a user opens a document that 
includes a linked object, the user is prompted to refresh the link. 

Pasting Excel into Word 
The most common practice among accounting practitioners is to paste financial data from Excel into 
Word. Word provides better control of headers, footers, and pagination, and generally provides for higher 
quality document printing, which is the raison d'être for using Word. When pasting Excel into Word, a user 
can choose from several different paste commands in the Clipboard group on the Home tab. 

1. Paste – Excel data is entered into a Word table with the source formatting intact. This result is 
equivalent to Paste Special, Formatted Text (RTF) or Paste Special, HTML. 

2. Paste Special, Formatted Text (RTF) – Excel data is entered into a Word table with the source 
formatting intact. This result is equivalent to Paste. 

3. Paste Special, HTML – Excel data is entered into a Word table with the source formatting intact. 
This result is equivalent to Paste. 

4. Paste Special, Unformatted Text – Excel data is entered as text in a Word document with each 
row on a different line in Word. Data from cells in adjacent columns are tabbed or spaced across 
the page. If a single cell or single column of cells containing text is pasted, each cell will be entered 
as a separate paragraph. The format of the data will take the characteristics of the Normal style 
in Word. 

5. Paste Special, Picture (Windows Metafile or Enhanced Metafile) – This is the equivalent in Word 
of pasting a Camera object in Excel. The source layout and formatting remain intact. Word will 
attempt to scale the picture to fit within the margins. Large pictures may be truncated. Windows 
Metafile pictures are 16-bit graphics while Enhanced Metafile pictures are 32-bit graphics. 

6. Paste Special, Bitmap – This is similar to Paste Special, Picture. The source layout and formatting 
remain intact and will yield better results when Paste Special, Picture auto-scaling distorts the 
image in some way. Bitmaps cannot be scaled and result in larger file sizes. 

7. Paste Special, Word Hyperlink – This creates a hyperlink to the data source. CTRL + Click the link 
to jump to the source file. The Excel data is entered into a Word table with the source formatting 
intact. This command is only available when pasting a link. 

8. Paste Special, Microsoft Excel Worksheet Object – This creates an embedded Excel object in a 
Word document that can be edited in place within Word. The source layout and formatting 
remain intact. 



 
 

Each of the Paste Special commands can be pasted with or without a link to the original Excel worksheet. 
Links allow updates made to the source worksheet to flow through to the target document whenever the 
link is refreshed. Note that the ability to paste links is not available when using the Paste buttons in Word. 

Under most circumstances, users will get better results by pasting a picture of an Excel range, such as a 
balance sheet, income statement, or cash flow statement, into Word rather than pasting the range as 
formatted text (the default). If your report will not fit on a single page in Word, paste multiple page-sized 
pictures instead because Word will only print the first page of multi-page linked or embedded Excel 
objects. This is an inherent limitation of all linked or embedded objects in Microsoft Office. 

Figure 1 shows the difference in results between Paste and Paste Special, Picture (Windows Metafile). 
Given the inherent problems of working with Word tables, pasting Excel data as a picture will give most 
users better results. 

 

Figure 1 - Pasting a Picture vs. Pasting Formatted Text from Excel into Word 

Report layout with 
Paste Special, Picture 

Table layout with Paste 



 
 

Pasting Static Pictures 
Pasting an Excel report or analysis as a picture into Word usually yields the best results. Simply highlight 
and copy the appropriate range (making sure not to exceed an area that will fit on one page) in Excel. 
Then, in Word, click Paste, Paste Special on the Home tab. Select Picture (Enhanced Metafile) and click 
OK. To remove the gridlines in the pasted picture, perform the following steps. 

1. Right-click on the picture and choose Properties to open the Format Picture pane. 

2. In the Format Picture pane, click the Picture icon at the top. 

3. Expand the Picture Corrections section. 

4. In the Presets drop-down gallery, select Brightness: 0% (Normal) Contrast: +40% to remove the 
gridlines as shown in Figure 2. 

 

Figure 2 – Removing Gridlines from a Static Picture 

Pasting Linked Pictures 
Paste links whenever flow-through reporting is desired. That way, as the data in the linked Excel 
worksheet is modified, the updated data will flow through to the Word document. However, when pasting 
linked pictures into Word from Excel, the pasted pictures do not have the picture correction options 
available with static pictures. That's because the entirety of the picture (layout, formatting, gridlines, etc.) 
flows through from the linked source worksheet. To remove the gridlines in Word, users must turn off the 
gridlines in the linked worksheet in Excel. Note that enabling the gridlines at a later time in Excel will again 
display them in the linked picture in Word. This behavior presents a problem for most users because they 

Brightness: 0% (Normal) Contrast: +40% 



 
 

depend on the gridline structure for formula building and navigation. To remedy this situation requires a 
rethinking of the report creation and presentation process. 

Most accountants build their analyses and reports for presentation or publication. Their work product is 
their presentation product. In a more sophisticated "flow-through" reporting environment, the work 
product and presentation product must be separated. In this case, we want the gridlines enabled for work 
but disabled for presentation. This can be accomplished easily by creating a presentation worksheet linked 
by formulas to the working worksheet within the same workbook. The gridlines are then disabled on the 
presentation worksheet, which serves as the source of the picture for linking into Word. Perform the 
following steps to create a presentation worksheet as shown in Figure 3. 

1. Insert a new worksheet and name it Balance Sheet Presentation. 

2. Highlight and copy the report of interest. In this example, highlight and copy the entire Balance 
Sheet consisting of the range A1:C65. 

3. Positon the cursor in cell A1 on the new presentation worksheet and click Paste, Paste Special to 
open the Paste Special dialog box. Click Paste Link to build formulas in the new worksheet linked 
to the original data. 

4. Without breaking the highlighted range, click Paste, Paste Special to open the Paste Special dialog 
box a second time. Select the Format radio button and click OK to paste the formats to the new 
worksheet. 

5. Again, without breaking the highlighted range, click Paste, Paste Special to open the Paste Special 
dialog box a third time. Select the Column widths radio button and click OK to adjust the column 
widths in the new worksheet. 

 

Figure 3 – Using a Triple-Paste Technique to Create a Presentation Worksheet 
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6. Note that blank cells in the original worksheet show up as zero in the presentation report. To 
eliminate the zeros, we need to modify the formula that was created by the process. Position your 
cursor in cell A4. Modify the formula so that it reads as follows.  

=IF('Balance Sheet'!A4="","",'Balance Sheet'!A4) 
7. Copy the formula down through cell A65 using the Auto Fill handle, making sure to select Fill 

Without Formatting in the Auto Fill Options box. Without breaking the highlighted range, copy 
the formulas across to column C, again making sure to select Fill Without Formatting in the Auto 
Fill Options box. Turn off the gridlines to complete the task. 

This simple process produces a worksheet that is identical to the original, except that it is built on formulas 
so that as the working sheet is updated, the changes flow through to the presentation sheet. It is this 
sheet that will serve as the source for linking pictures into Word. When using linked pictures, Paste Special, 
Paste link: Bitmap will usually yield the best results. 

Pasting Multi-Page Reports 
Word will only print the first page of multi-page static, linked, or embedded Excel objects. If your report 
will not fit on a single page in Word, paste multiple page-sized pictures instead. In order to get the three- 
or four-line report headings to repeat and print on the second and succeeding pages, use page headers in 
Word. The header in Word can be typed in or copied from the Excel report presentation sheet. If the 
header is linked to Excel, the report header in Word will be updated whenever the Excel report is changed. 
For example, in linking a two-page Balance Sheet into Word, apply headers containing the statement 
headings to the Word document. First, paste the Asset section into the report body on the first page, 
insert a page break, and then paste the Liabilities and Equity section into the report body on the second 
page. To produce a linked multi-page Balance Sheet with linked headers in Word, do the following.   

1. First, highlight and copy the Balance Sheet headings (cells A1:A3) from the Balance Sheet 
Presentation worksheet (without gridlines). Open Word to a blank document. Double-click in the 
header margin to open the Header section. Click inside the Header section and select Paste, Paste 
Special, Paste link: HTML Format. This will insert a linked Word table as the document header. 
Press Return so that there are two blank rows following the linked table to provide head space 
for the report. Click in the Document section to close the Header. 

2. Highlight and copy the Asset section of the Balance Sheet (cells A6:C35) from the Balance Sheet 
Presentation worksheet and paste it into Word using Paste, Paste Special, Paste link: Bitmap.  

3. Press CTRL + Enter to enter a page break in the Word document. 

4. Next, highlight and copy the Liabilities and Stockholders' Equity section of the Balance Sheet 
(cells A38:C65) from the Balance Sheet Presentation worksheet and paste it into Word using 
Paste, Paste Special, Paste link: Bitmap. 

The process to produce this linked multi-page report in Word is displayed in Figure 4. Using this design 
strategy, accountants and business professionals can easily create reports in Word that are linked to the 
underlying data in Excel. As the Excel report is modified, the changes will flow through to the Word report, 
improving productivity while reducing errors. Users will be prompted to update the report each time the 
Word document is opened. Moreover, the pictures serve as hyperlinks to the source Excel workbook. 
Double-clicking on a linked picture will open Excel and the workbook to which the picture is linked. To 
prevent broken links, make sure the files are in the same folder when the links are created and store or 
move them together in a single folder. 



 
 

 
Figure 4 – Creating a Multi-Page Linked Report in Word 

Pasting Camera Objects 
The Camera in Excel, which will be covered comprehensively in Excel's Top 15 All Time Hints and Tips, 
allows users to cut and paste dynamic pictures of data ranges, which can then be arranged in any layout 
for display or printing. To use the Camera, first add the tool to the Quick Access Toolbar (QAT) in Excel. 
Just click on the drop-down arrow at the far right end of the QAT and select More Commands. In the Excel 
Options dialog box, select Commands Not in the Ribbon. Scroll down the list of commands and select the 
Camera tool. Click Add and then OK to close the dialog box as shown in Figure 5. 

The use of the Camera is very similar in operation to cut and paste. Highlight the range to be copied and 
then click the Camera toolbar button. Navigate to the worksheet that will serve as the composite report 
and click with your mouse on the sheet to paste a picture of the data snippet. Similarly, Camera objects 
can be pasted into Word documents. To paste a static Camera object into Word, select Paste, Paste 
Special, Picture (Enhanced Metafile) and click OK. A Picture Correction must be applied to eliminate any 
visible gridlines. 

Paste Special, Paste link: HTML Format 

Paste Special, Paste link: Bitmap 



 
 

 

Figure 5 - Adding the Camera to the QAT 

To paste a linked Camera object into Word, select Paste, Paste Special, Paste link: Bitmap and click OK. A 
Picture Correction will not eliminate any visible gridlines. The gridlines must be disabled in the source 
Excel worksheet as covered previously. 

Embedding Excel in Word 
Creating or pasting an Excel worksheet object in Word provides users with the ability to format the 
embedded or linked object in place. In other words, there is no need to open Excel to modify the object. 
Just double-click on an Excel object, and Word will transform itself into Excel and allow full editing and 
control of the worksheet. When editing is complete, just click in the Word document outside of the Excel 
object, and the application will transform itself back into Word. This is very useful for small tables or 
analyses that accompany a report. Since the data is embedded in the report and not in a separate Excel 
workbook, users can easily update the data when necessary. Note that if you link or embed a multi-page 
Excel object in Word, only the first page of the object will print in Word. 

Embedding a New Workbook 
There are several ways to embed Excel objects in Word. To insert a new Excel workbook, click Insert, 
Table, Excel Spreadsheet. Alternatively, click Insert, Object, Microsoft Excel Worksheet to insert a new 
workbook. Note the wide variety of objects that can be embedded. In both instances, a blank workbook 
displaying seven columns by ten rows will be added to the document. The workbook object can be resized 
by dragging the borders. The ribbon will reflect the tabs and commands found in Excel, and users will have 



 
 

full Excel functionality while the object is open. In effect, Word has transformed itself into Excel. Note that 
a single worksheet tab is displayed in default, but users may add additional worksheets and build very 
sophisticated models within the object. When a user completes the object editing process and clicks back 
into Word, the object will reflect whatever is visible when the editing process is ended. In other words, 
the space within the object borders represent a window to the underlying workbook object. To adjust 
what is seen in Word, activate the Excel object and then select and scroll the desired worksheet to change 
what is displayed. Make sure to turn off the gridlines before you end the editing process! Figure 6 shows 
an Excel object being edited inside a Word document. 

 

Figure 6 - Editing an Embedded Excel Worksheet Object in Word 

 

Embedding an Existing Workbook 
There are several ways to embed existing Excel objects in Word. The simplest way is to copy a range in an 
existing worksheet and then paste it into Word using Paste, Paste Special, Microsoft Excel Worksheet 
Object. Alternatively, click Insert, Object. On the Create from File tab, click Browse, select the desired 
workbook in the file system, and click Insert. Click OK to complete the process and embed the Excel 
workbook in Word. Both methods embed a copy of an existing Excel workbook into Word that is 



 
 

disconnected from the original workbook. To edit an embedded object, double-click on the object. Note 
that users may choose to paste a linked Excel worksheet object. Linked worksheet objects display the 
same characteristics and functionality as linked pictures covered previously. 

Review of Linked and Embedded Objects 
The main differences between linked objects and embedded objects are where the data is stored and how 
the data is updated after you place it in a Word document. When an Excel object is linked, information 
can be updated if the source file is modified. Linked data is stored in the source file. The Word document, 
or destination file, stores only the location of the source file and displays a representation of the linked 
data. Linking is useful when you want to include information in a document that is maintained 
independently, such as data collected by a different department or staff member, and when you need to 
keep that information up-to-date in a Word document. 

When an Excel object is embedded in a Word document, information in the Word document doesn't 
reflect changes in the source Excel file because the document and the source workbook are disconnected. 
Embedded objects become part of the Word file. After they are inserted in Word, their data is accessible 
and modifiable only within the document in which they are embedded. Because all of the data is contained 
in a single Word document, embedding is useful when you don't want the information to reflect changes 
in the source file, or when you want document recipients to be able to update the data easily from within 
Word. 

Updating Linked Objects 
In default, linked objects are updated automatically. This means that Word updates the linked information 
every time a user opens the Word document or any time the source Excel file changes while the Word 
document is open. However, users can change the settings for individual linked objects so that a linked 
object is not updated or so that it is updated only when a reader chooses to update it manually. 

Users can also permanently break the connection between a linked object and its source Excel workbook. 
When the connection is broken, the object becomes a static picture of the Excel content and users can no 
longer edit the object in the Word document. 

To modify the way links are updated, click File, Info and then click Edit Links to Files. In the Links dialog 
box, highlight the link to be updated or configured. 

1. To update the link, click Update Now. 

2. To configure the link for manual updating, select Manual update in the Update method for 
selected link section. 

3. To prevent a link from being updated, check Locked in the Update method for selected link 
section. 

4. To break the connection between a linked object and its source, click Break Link. 

To disable automatic updating of all linked objects in Word, click File, Options, Advanced. Scroll down to 
the General section and uncheck Update automatic links on open. 



 
 

Linking Cells into Word 
A powerful reporting technique is to embed and link single Excel cells within Word text. For example, an 
Excel workbook could contain an income statement of a particular client. Whenever a related Word 
document makes reference to specific values in the income statement, the required values could be linked 
from the Excel workbook. Do the following to link single cells of Excel data into Word. 

1. From within Excel, copy the appropriate cell to the clipboard. 

2. In Word, put the cursor at the point where the Excel value is to be inserted.  

3. From the Home tab, select Paste, Paste Special, Paste link: Unformatted Text. Make sure to 
select Paste link so that changes in Excel will flow through to the text in Word. Click OK to 
complete the operation. Unformatted Text is chosen so that the formatting of the inserted cell 
will match the style of the surrounding text in the Word document. 

4. Insert spaces as desired to space the Excel value properly within surrounding text. 

Figure 7 shows the process of pasting a single Excel cell into Word text. Note the Paste link selection on 
the left in the Paste Special dialog box. In this example, the reporting entity, reporting date, and all four 
amounts have been pasted from Excel with links. Each pasted value is treated as a field in Word, hence 
the gray shading when the cursor is positioned inside a value. 

 

Figure 7 - Pasting Single Excel Cells into Word Text 



 
 

Linking Cells with the Accounting Format 
Excel's Accounting Format adds a space to the beginning and end of any pasted value, which may cause 
spacing problems in a Word document. This is especially troublesome when a value linked from Excel ends 
a sentence or has punctuation marks immediately following the linked cells. The sentence ending period 
or other punctuation mark will appear one space to the right of the value. This cannot be corrected from 
within Word. Users must change the source formatting of the linked cells to Currency in Excel, with or 
without the dollar sign, and with the appropriate number of decimal points. If the cell is linked into Word, 
the format change will flow-through. Otherwise, re-paste static values. 

Since most accountants and business professionals routinely use the Accounting Format in their financial 
reports, having to change formats just to facilitate linking cells into Word is unpalatable. To work around 
this issue, we can employ a strategy similar to the one employed in linking entire reports. In this case, we 
will create a new worksheet for Linked Cells that contains formulas referencing the original worksheets. 
The values on the Linked Cells worksheet will be formatted with the Currency format. These are the cells 
that will be linked to Word, thereby providing the number formats necessary to produce "flow-through" 
reporting without changing the number formats on the original reports as shown in Figure 8. 

 

Figure 8 – Using Linked Cells to Overcome the Problem of Using the Accounting Format in Reports 

Linking Cells from Embedded Worksheets 
In the previous section, cells were linked from existing Excel workbooks into Word documents in order to 
integrate financial data into the text of a report. This same process of linking cells into report text is also 
available with embedded objects. This is especially useful in performing templated engagements, such as 
producing a draft business plan for a client. Having the analysis embedded in the reports themselves saves 
time and eliminates problems associated with linked documents. The templates envisaged would contain 
embedded Excel placeholders for analysis with the key cells already linked to the appropriate report text. 
Simply filling in and completing the analysis in the embedded Excel worksheets would produce most of 



 
 

the report. Figure 9 displays a template with an embedded Excel worksheet that contains cells that are 
linked to the report text. 

 

Figure 9 – A Template with an Embedded Excel Worksheet Linked to Report Text 

Pasting Word into Excel 
A less common practice among accounting practitioners is to paste footnotes or reports from Word into 
Excel. While Word provides better control of headers, footers, and pagination, the bulk of analysis and 
data usually resides in Excel. Under these circumstances, some practitioners prefer to paste financial 
footnotes and other short reports from Word into Excel for printing in order to avoid the common 
problems associated with pasting Excel data into Word. When pasting Word into Excel, a user can choose 
from several different paste commands on the Home tab. 

1. Paste – Each paragraph of Word data is entered into a single cell in Excel with consecutive 
paragraphs being entered one after the other in a single column. The source formatting remains 
intact, but the text does not bleed over to adjacent blank cells on the right as text in Excel normally 
does. 



 
 

2. Paste Special, HTML -- This is the equivalent of Paste. Each paragraph of Word data is entered 
into a single cell in Excel with consecutive paragraphs being entered one after the other in a single 
column. The source formatting remains intact, but the text does not bleed over to adjacent blank 
cells on the right as text in Excel normally does. 

3. Paste Special, Text – Each paragraph of Word data is entered into a single cell in Excel with 
consecutive paragraphs being entered one after the other in a single column. The format of the 
data will take the characteristics of the default style in Excel. The text bleeds over to adjacent 
blank cells on the right as labels in Excel normally do if the cells in which the Word data was pasted 
are formatted as General, Number, Currency, or Percentage. If the cells are formatted as 
Accounting, the pasted text will not bleed over to adjacent blank cells when the text exceeds 280 
characters. Limitations also apply to the number of characters that will bleed over to adjacent 
blank cells when the cells are formatted as Text. 

4. Paste Special, Unicode Text -- This is the equivalent of Paste Special, Text except the text is in 
Unicode format. 

5. Paste Special, Hyperlink – This creates a hyperlink to the data source. Click the link to jump to the 
source file. All of the text is entered in a single cell, but text that exceeds 255 characters is 
truncated. The text bleeds over to adjacent blank cells on the right as labels in Excel normally do 
if the cells in which the Word data was pasted are formatted as General, Number, Currency, or 
Percentage.  

6. Paste Special, Picture (Enhanced Metafile) – This is the equivalent of pasting a Camera object in 
Excel. The source layout and formatting remain intact. Excel will truncate any picture that is 
greater than one page in length. If Paste Special, Paste link: Picture (Enhanced Metafile) is 
chosen, any changes to the source document will flow through to the Excel worksheet.  

7. Paste Special, Microsoft Word Document Object – This creates an embedded Word object in an 
Excel worksheet that can be edited in place within Excel. The source layout and formatting are 
intact. 

Each of the Paste Special commands can be pasted with or without a link to the original Word document. 
Links allow updates to the source document to flow through to the target worksheet whenever the link is 
refreshed. 

Pasting a formatted sentence, paragraph, or document from Word into Excel will almost always yield 
unsatisfactory results. If you want fully formatted text, you will get better results by pasting a picture of a 
Word page, such as the notes to financial statements, or by inserting or pasting a Microsoft Word 
Document Object into Excel. Pictures greater than one page in length will be truncated, and only the first 
page of multi-page Microsoft Word Document Objects will print from within Excel. Paste multiple page-
sized pictures or objects to work around these limitations. 

If you want to manipulate and format your data in Excel, use Paste, Paste Special, Text. Each paragraph 
will be pasted into an individual cell. However, make sure that you format the column in which you paste 
the data to the General format so that the text will bleed over to adjacent blank cells on the right. Cells 
containing text in Excel can contain, display, and print up to 32,768 characters if the cells containing the 
labels are formatted as General (or Number, Currency, or Percentage), which is more than sufficient to 
hold a paragraph of text pasted from Word. Figure 10 displays the differing results of pasting Word text 



 
 

into Excel. Note that the method used in pasting the data and the number format applied to the 
destination cells determine how the data will be displayed in Excel. 

 

Figure 10 – Differing Results of Pasting Word Text into Excel 

To manipulate and format text pasted from Word, do the following.  

1. Apply the General format to column A that will serve as the destination for the pasted text from 
Word. 

2. Modify the margins so that the Left and Right margins are set to 1 inch, and content is Centered 
on page: Horizontally. Set any headers and footers to align with the 1-inch margins. Click the 
Header/Footer tab in the Page Setup dialog box and check Align with page margins. 

3. Paste the text from Word into the column A using Paste Special, Text. The text should bleed over 
blank cells to the right of the paste column. 

Using Paste Special, Text with destination cells 
formatted using the Accounting Format 

Using Paste 

Using Paste Special, Text with destination 
cells formatted using the General Format 



 
 

4. Open and close Print Preview to force a vertical page break to be visible on the screen. Widen 
column A to the visible page break. 

5. Adjust the cell alignment for the destination column. Click column A, then right-click and select 
Format Cells in the context-sensitive menu. On the Alignment tab, set the Horizontal alignment 
to Justify and Vertical alignment to Top. Check Wrap text so that text wraps in the cells and click 
OK. 

6. Adjust the row heights of cells as required. Apply any necessary formatting (boldface, underline, 
etc.) to complete the copied report. The completed report should resemble the one in Figure 11. 

 

Figure 11 – Copied Word Text Formatted for Printing in Excel 



 
 

 

To help you understand the potential for integrating text in Excel, Figure 12 displays notes to the financial 
statements formatted for printing. In this example, each paragraph is contained in a single cell. 

 

Figure 12 - Notes to Financial Statements Formatted for Printing in Excel 

Embedding Word in Excel 
Similar to the way we embedded Excel objects in Word earlier in this presentation, we can embed Word 
objects in Excel. This may be useful for consolidating a textual report with its supporting analysis in a single 
file or for combining notes to the financial statements with the statements themselves. This alleviates the 
need to maintain multiple files per engagement. Word objects are also useful for providing explanatory 
text to complex reports, analyses, or charts. Instead of using the cell-based textual capabilities of Excel, 
users can have the full functionality of Word to write explanations or make annotations. 

Embedding an Exiting Word Document 
To insert an existing Word document into an Excel workbook, select or insert a blank worksheet. Then, 
choose Object from the Insert tab of the ribbon to open the Insert Object dialog box. Select Create from 
file and click Browse. Navigate the file system to the desired Word document, select it, and click OK to 
complete the process. This will cause the contents of the document to appear on a worksheet in Excel as 
shown in Figure 13. Alternatively, copy the document in Word and then paste it into Excel using Paste 
Special, Microsoft Word Document Object. In both cases, users may choose to link the embedded object 



 
 

to the original document. This produces the same results as pasting a linked picture using Paste Special, 
Paste link: Picture (Enhanced Metafile). Note that users may choose to have the embedded or linked 
document displayed as an icon, which allows quick and easy access to related documents from within an 
Excel workbook. 

Recall that only the first page of an embedded object will be displayed and printed in a host document. 
This is more problematical with Word objects because of the way text flows from page to page. If the 
documents are less than a page, embedded Word documents work well. For satisfactory results, simply 
adjust the margins to fit the document properly, scale the embedded object "image" to fit the vertical 
page break, and remove the borders. To scale the image, simply grab the right-edge of the "image" with 
your mouse and resize it accordingly. To remove the borders, right-click on the object and select Format 
Object. In the Format Object dialog box, click the Colors and Lines tab and then select No Line in the Line 
Color drop-down box. If the original document is larger than a page, better results can be achieved by 
importing text using Paste Special, Text, as covered previously in this session. This will allow the text to 
be manipulated and formatted in Excel. 

 

Figure 13 – Word Objects May Be Embedded or Linked by an Icon 

Word Document Objects may be 
embedded or linked by icon 



 
 

Embedding a New Word Document 
The process for embedding a new Word document in Excel is the same as embedding an Excel worksheet 
in Word. For example, Word objects may be useful for providing explanations for analysis or charts as 
shown in Figure 14. With Word objects, users have the full functionality of Word – bulleted or enumerated 
lists, simple indention with tab settings, case management, etc. To insert a new Word document object, 
first positon your cursor in the worksheet where the object is to be inserted. Then, click Insert, Object on 
the ribbon, select Microsoft Word Document as the Object type, and click OK. Adjust the size of the object 
to fit your needs and remove the borders, if desired. Double-click on the object to activate it; click 
anywhere on the face of the worksheet to deactivate it. 

 

Figure 14 – Using a Word Object for Explanatory Text in Excel 

Embedding Excel in PowerPoint 
On occasion, you might find it beneficial to embed an Excel file in a PowerPoint presentation. This allows 
you to open that file while the presentation is running so that your audience can see the contents of the 
file. For accounting and finance professionals, this is often the case when delivering a presentation on a 
company's financial condition, and someone in the audience wants to see more details. If you have 
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embedded the company's financial statements in Excel, then opening these statements while the 
presentation is running is a snap. 

Embedding an Existing Workbook 
To insert an existing Excel workbook into a PowerPoint presentation, choose Object from the Insert tab 
of the Ribbon to open the Insert Object dialog box shown in Figure 15. Since the workbook already exists, 
select Create from file, browse to the file you want to insert, select it, and click OK to complete the 
process. This will place the contents of the file on the current PowerPoint slide. Alternatively, you may 
select the Display as icon option on the Insert Object dialog box to have the workbook displayed as a 
small icon. Clicking on the icon will open the embedded workbook for viewing. 

 

Figure 15 - Insert Object Dialog Box 

Inserting an object such as an Excel workbook embeds the object into the PowerPoint file. If the object is 
very large, embedding it may cause the size of the PowerPoint file to become very large. If that's the case, 
you can link the file by checking Link in the Insert Object dialog box. This inserts the contents of the 
workbook as a linked picture in PowerPoint without actually storing the object as part of the PowerPoint 
file. Double-click the linked picture to open the source workbook. Keep in mind that if you link to a file 
that is not stored on your computer, and you are traveling away from the office and cannot connect to 
the network on which the file is stored, you will not be able to update the linked information until you are 
able to establish a connection to the network. 

Consider the PowerPoint slide pictured in Figure 16. The financial data contained in the slide is actually a 
PivotTable in an Excel workbook embedded in the PowerPoint presentation. If, when delivering the 
presentation, a participant questioned one of the numbers or wanted to see the information filtered 
differently, the presenter would be able to activate the PivotTable and make the necessary modifications.  

Because the PivotTable is an embedded Excel object, the presenter could return to Normal view in 
PowerPoint, right-click on the embedded object, choose Worksheet Object, and then select from Edit, 
Open, or Convert. Selecting Edit opens the Excel document from within PowerPoint. In effect, PowerPoint 
turns into Excel similar to the way that Word turned into Excel previously. Note that simply double-clicking 



 
 

the object in PowerPoint will also cause Excel to open the object in PowerPoint for editing. At this point, 
users can manipulate the Excel object using any desired Excel functionality. Regardless of how you access 
Edit mode, clicking outside the object will restore PowerPoint to normal use. 

 

Figure 16 - Excel PivotTable Embedded in PowerPoint 

If you choose to Open the object instead of Edit, the object opens in a separate Excel window, leaving the 
PowerPoint window open and unchanged. Again, you will have access to all Excel functionality in the new 
window. As you make changes to the Excel workbook, you will see those changes propagate in real time 
to PowerPoint. In both cases – Edit or Open – once the document is opened, changes made, and the focus 
returns to the PowerPoint document, saving the PowerPoint document also saves any changes that were 
made to the embedded Excel workbook. 

Embedding a New Workbook 
Similar to creating a new Excel object in Word, users can embed new Excel objects in PowerPoint. There 
is no need to use Excel as an independent application to create simple financial analysis. Simply select 



 
 

Insert, Object, Excel Worksheet from the ribbon, making sure to select Create new in the Insert Object 
dialog box as shown in Figure 17. Users will have full Excel functionality from within PowerPoint whenever 
the object is activated. 

 

Figure 17 - Inserting a New Embedded Workbook in PowerPoint 

Pasting Excel into PowerPoint 
While PowerPoint includes the full range of Paste Special commands (Microsoft Excel Worksheet Object, 
HTML Format, Formatted Text (RTF), Unformatted Text, Picture (Enhanced Metafile), Picture (Windows 
Metafile), Device Independent Bitmap, and Bitmap), it has limited capabilities for pasting linked data 
(Microsoft Excel Worksheet Object and Attach Hyperlink). Note that users can embed existing worksheet 
objects using Paste Special with or without links to the original workbook. If gridlines are visible in a linked 
worksheet, the gridlines will flow through to PowerPoint. To eliminate the gridlines, use a strategy similar 
to the one described earlier in this session for linking Excel worksheets into Word. 

Users may also paste Excel data into PowerPoint as text or pictures similar to the way that Excel data can 
be pasted into Word. All of the available options for pasting Excel data into PowerPoint is available in the 
Paste Options box similar to the one displayed in Figure 18 for pasting charts. Whenever pictures are 
pasted, make sure to use a picture correction to eliminate visible gridlines. 

Embedding Charts in Word and PowerPoint 
When most users think of charts, Excel is the first tool that comes to mind. However, users can create and 
modify charts in Word and PowerPoint in the same manner as they would in Excel. In fact, all three 
applications use the same charting engine. PowerPoint has the most advanced charting functionality 
because it can animate charts. Neither Excel nor Word has that capability. To create a chart in Word, click 
Insert, Chart on the ribbon and then select the desired chart type and click OK. Word will create an initial 
chart and insert an Excel data sheet to hold the chart data. Users can add, edit, or delete the data as 
required. When the document is saved, the data sheet is imbedded in the document so that the data will 
be included with the document wherever it goes. Because of the common charting tool, the process for 



 
 

creating a chart in PowerPoint is virtually identical to the process of building a chart in Word. Choose 
Insert, Chart on the ribbon, select the desired Chart Type, and click OK. As with Word, the chart data is 
stored in an Excel worksheet embedded in the slideshow. 

Pasting Excel Charts into Word or PowerPoint 
In situations where charts have already been created in Excel, users can copy and paste these charts into 
Word or PowerPoint quickly and easily. Whenever an Excel chart is pasted into Word or PowerPoint, the 
Paste Options box appears at the bottom right-hand corner of the pasted chart as shown in Figure 18. 
Select whether to link or to embed the chart and whether to keep the source formatting or to use the 
destination theme. Note that pasting a chart as a picture is the least desirable option available because a 
picture is a static image that cannot be edited in any way for presentation. Users will not be able to adjust 
font sizes or colors or add animation to the chart for more effective presentation. 

 

Figure 18 - Pasting an Excel Chart into Word or PowerPoint 



 
 

Animating Charts in PowerPoint 
When displaying a chart during a presentation, the attention of the audience is likely to be focused on the 
meaning of the chart as a whole, while ignoring the explanation being delivered by the presenter. 
PowerPoint allows users to control the animation of the data elements. Instead of displaying the entire 
chart at once, data elements can be presented in the order desired by the presenter, thereby holding the 
audience's attention more effectively while the chart is being displayed and explained. Linked and 
embedded Excel charts can be animated just as charts created in PowerPoint. 

To control animation of a chart, add the desired Entrance effect to the chart. Then, right-click on the 
Entrance effect and select Effect Options followed by the Chart Animation tab as shown in Figure 19. In 
the Group Chart box, select the desired animation effect. Now when the chart is displayed in a 
presentation, the data elements will be animated and will appear as specified by the presenter. 

 

Figure 19 - Adding Animation to a Chart 

Dynamic Chart Titles 
Communicating effectively with charts requires a strategy. Before creating a chart, take time to determine 
what is to be communicated by the chart and what type of chart will be most effective at communicating 
the message. If possible, include the message in the title of the chart. Use string arithmetic to create 
dynamic chart titles that change automatically when the data is updated. Make sure to link the dynamic 
title to the chart title placeholder and not a text box if you plan on embedding or linking the chart in Word 
or PowerPoint as shown in Figure 20. Note how well the chart communicates the intended message. 



 
 

 

Figure 20 – Using String Arithmetic to Create Dynamic Titles 

Using Hyperlinks to Link Excel Data to PowerPoint 
Rather than linking or embedding Excel worksheets in PowerPoint slideshows, users can use simple 
hyperlinks to access detail data during a presentation. To make data access seamless, users should add 
the Back and Forward buttons to their Quick Access Toolbar (QAT) in Excel, Word, and PowerPoint. Simply 
click the down arrow at the far right end of the QAT and select More Commands. From the All Commands 
pane, add Back and Forward as shown in Figure 21. 

 

Figure 21 – Add the Back and Forward Buttons to the QAT when Using Hyperlinks 

To insert a hyperlink into a PowerPoint slideshow, highlight the text or object that will serve as the link 
and then select Insert, Hyperlink from the ribbon. Click Existing File or Web Page in the navigation pane 

Add the BACK and FORWARD buttons to your 
Quick Access Toolbar when using hyperlinks to 
access detail data. 



 
 

on the left and then select the appropriate file and click OK as shown in Figure 22. Before the presentation, 
make sure to rearrange the worksheet and the worksheet zoom so that the data displays as desired during 
the presentation. 

 

Figure 22 – Using Hyperlinks to Access Detail Excel Data from within PowerPoint 
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